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Welcome. . ..

.. . to Digital Photography for Graphic Communications! This book is based on a 2009 print book by the authors
that was called Digital Photography for Print and published by the Printing Industries of America (PIA) Press.

The authors realize that graphic communications management has expanded to include a multitude of media in
addition to print, especially the web and apps. Thus we decided to revise the original book with a more inclusive
title.

The purpose of this book is to serve as a reference for a one-semester course in digital photography for graphic
communications. Since digital cameras have mostly replaced colour scanners, graphic communicators need
to capture images for use in magazines, catalogs, brochures, packages, signs, banners—all forms of printed
materials—and also for eBooks, web sites, and apps.

Thus the graphic communicator may be more concerned with product and still-life photography, portraiture,
and reproduction of flat work than with artistic photography. Of course the reproduction of photographers’ and
photojournalists’ work is still in the purview of the graphic communicator, and therefore photographers may find
some information of benefit in the book.

In any case, the authors hope our work will help production photographers produce work better, faster, and
cheaper.
Acknowledgements

The authors would like to thank the Printing Industries Press, Pittsburgh, Pennsylvania, for granting the right to
publish this update as an open source eBook.






Chapter 1 * Introduction (Rich)

A long time ago—Tlonger than many of us can remember—print jobs were produced from hardcopy known as
mechanicals. Graphic communications was a slow and steady giant; nothing changed for years.

Then, in 1985, print production was turned upside down by the introduction of the Macintosh computer, the Apple
LaserWriter printer, and Aldus PageMaker page-layout software—and the word “digital” came to printing. Who
knew that a string of zeros and ones could alter graphics completely? First type became digital, then layout, and
today photography.

Prior to digital photography images were captured on film, and scanned in or “digitized.” Further back, color
separations were made with enlargers or process cameras equipped with red, green, blue, and visual (white) filters.
The first digital cameras were developed by NASA in the late 1970s so astronauts could send pictures from
space. By the mid 1990s, they were being commercialized. Their low resolution made them unsuitable for print
production. They were also expensive, awkwardly sized, and battery gluttons, and the average camera only held
30 images. Unless you had a computer handy, it was easier to carry extra rolls of film.

Improvements in resolution, size, battery life, memory capacity, turned digital cameras from toys into tools of
the trade. Scanning has become a process of the past, and digital cameras are becoming the primary vehicles of

image capture. The technology has developed so quickly that our processes need to catch up—particularly from
the production perspective.

Figure 1-1. Panoramic view of Que-NET Media’s digital photography studio in Toronto, Canada. The company now uses digital
photography for almost all image capture in its catalog production.
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Now, image capture has become the responsibility of creatives, who have traditionally not been responsible for
the accurate reproduction of their work. They have taken over for color trade shops and prepress houses, who
manipulated and corrected scanned photos.

Although numerous trade books are available on photography and digital cameras, none have been specifically
written for the graphic communications industry, or in particular, for those who now use digital cameras to do
work that was once done by a scanner. Thus, this book attempts to address the many considerations of digital
photography as a graphic reproduction, rather than as an aesthetic, medium.

Industry Trends in Color Imaging

Digital photography has come to replace scanning in graphic arts for several reasons (Figure 1-1). First, cameras
have been increasing in quality and declining in cost, particularly the 6-12 megapixel digital SLR (single-lense
reflex) category. Second, digital photography offers greater production speed by avoiding film processing and
cleaning, mounting, and dismounting of film or prints. Third, digital photography offers higher image quality by
avoiding dust and artifacts and by providing a truer color match to the original scene. Finally, of course, digital
photography offers real-time results. The image can be previewed immediately on the camera’s LCD panel or in
a studio situation the camera may be tethered to a computer screen. Digital camera systems can also display in
real-time the image histogram, thus allowing for technically correct exposures.

As a capture mechanism for print, major considerations in digital photography include the number of megapixels
required for reproduction (Figure 1-2) and the quality of captures as determined by exposure, white balance,
application of ICC profiles, and other settings. These issues require photographers with knowledge of digital
equipment and its use in graphic reproduction.
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Figure 1-2.

Current Camera Technologies

Digital cameras have been classified by PIA/GATF into three categories: consumer, prosumer, and professional
(Table 1-1). Megapixels and costs are stated for comparative purposes only, as every year new cameras are

introduced at a lower cost and with high resolution.

Table 1-1. Digital Camera Types

Camera Type Format Megapixels Cost
Consumer point-and-shoot 10-20 <$500
Prosumer professional point-and-shoot, DSLR or mirrorless 12-36 $500-$3,000+
Professional full-frame DSLR, medium format, or view camera with digital back 24-40+ $3,000—40,000+

Camera Requirements

The main requirement for a digital camera used for graphics reproduction is sufficient resolution, measured in
megapixels. The camera must be able to capture enough pixels for the required image resolution, based on the



6 * DIGITAL PHOTOGRAPHY FOR GRAPHIC COMMUNICATIONS

number of pixels per inch required to support the printed screen ruling. For example, an 8.5%11-in. magazine page
printed at 150 Ipi requires 300 ppi image resolution, necessitating a digital camera of at least 8.5 megapixels. Users
should be aware of the difference between real pixels and interpolated pixels. Often manufacturers may quote
higher pixel numbers than really exist in the sensor, in this instance the vendor is computing new pixel information
using software interpolation techniques. Better quality is rarely achieved using interpolated pixel information.

How Printers Use Digital Cameras

Since graphic arts professionals use digital cameras as a replacement for scanners, we distinguish between the
technical and aesthetic side of photography. The following types of digital photography are useful in the graphic
arts.
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Figure 1-3. Different types of digital photography useful in graphic communications: A, B. Copy work to reproduce artwork, illuminated
evenly at a 45° angle. C. Macro work at actual size, or 1:1 reproduction ratio, on the camera’s sensor D. Product photography through a
tabletop light diffuser.

Copy work. Copy work refers to images captured of flat work for reproduction (Figure 1-3 A, B). Examples
include logos, photographs, paintings and other artwork. For best results, illuminate copy evenly with lights at a
45° angle to the copy surface to eliminate glare.

Macro photography. Macro photography refers to extreme close-ups (Figure 1-3 C) as might be required for
scientific and technical photography, education, training, documentation, or small product photography. Macro
photography requires a macro lens, a special lens designed for close-up photography, or a zoom lens with macro
capability. How close the lens can focus is usually described as the reproduction ratio. For example a 1:1 macro
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lens can capture an image on the camera’s sensor that is the object’s actual size. A 2:1 macro lens can capture an
image that is half the size of the original.

Product photography. This is photography of small to large items for reproduction in catalogs, newspapers,
brochures, flyers, ads, signs, internet auctions, and other reproduction methods (Figure 1-3 D). Depending upon
the size of the item, various lighting accessories may be used, including light tents, diffusers, and natural lighting.

Still life. Refers to collections of subjects, whether set up on a table top or on the floor. Examples include artistic
groupings of objects or groups of complementary accessories for catalog photography (Figure 1-3 E).

Portrait. Portraits refer to posed (vs. candid) photos of people, individually or in groups (Figure 1-3 F). Examples
include yearbooks, biographical head-and-shoulders “mug shots,” and group photos of people. Generally faces
reproduce best when photographed with a short-range telephoto lens, as in the 70-120-mm focal length. A
telephoto lens compresses distance from front to back, which often flatters the face.

Architectural. This refers to photographs of buildings and rooms (Figure 1-3 G), including photography for
real estate brochures and catalogs as well as furniture, decorative accessories, and interior design. Architectural
photography can benefit from a wide-angle lens, which captures a wider view of the scene than a normal lens.

Landscape & scenery. This category includes outdoor and scenic photography, as might be used in travel or
recreational magazines, catalogs, and brochures (Figure 1-3 H).
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Figure 1-3 E-H. E. Still life. F. Portrait. G. Landscape. H. Architectural.
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How to Use this Book
This book is divided into eight chapters including this introduction. The other chapters are:

Chapter 2, “Equipment,” discusses what the graphic arts user needs for the most common types of digital
photography. This includes digital cameras, lenses, lighting, and accessories such as tripods, cable releases, filters,
and the like.

Chapter 3, “File Formats and Applications,” discusses the most common file formats used to save digital
photographs onto computer media such as hard disks, CD- and DVD-ROM disks, USB “jump” drives, and servers
for viewing on the World Wide Web. The chapter also discusses applications used to edit, layout, and print digital
photos.

Chapter 4, “Color Management,” describes how to use ICC color management profiles to get the most accurate
digital captures, accurate on-screen display, and accurate printed and proofed color.

Chapter 5, “Image Fidelity,” discusses how to achieve images that match the original scene as closely as possible.
In this chapter, we refer to image fidelity concepts that were derived from the setup of high-quality drum scanners
to help users get the best scan “the first time, every time.”

Chapter 6, “Working with Printers,” eBook Publishers, and Web Designers describes the processes that digital
photos must go through to be printed using offset lithography as well as reproduced in eBooks and on the Web.
This will be of interest to readers who plan to publish their work in some type of printed media.

Chapter 7, “Pricing Digital Photography,” describes how to estimate for production of digital photographs in a
commercial service provider environment, such as a studio or print shop.

Chapter 8, “Working with Photoshop,” describes how to do non-destructive editing in this program.



Chapter 2 * Studio Equipment (Rich)

This chapter discusses what you’ll need to set up a digital photography studio. In addition to the digital camera,
you may need additional lenses, filters, studio lighting, lighting diffusers and reflectors, light stands and quality
control devices to help make your photos accurate and consistent.

Canon

Figure 2-1. Camera systems. A. A Canon S120 (12MP) professional point-and-shoot camera with fixed lens. B. A Canon EOS M100
mirrorless camera (24MP) with removable lenses. C. A Pentax K-r DSLR (16 MP), D. A Hasselblad professional medium-format camera
with a digital back (40MP).

Camera System

A digital camera is the first thing you’ll need for a digital photography studio. Digital cameras are commonly
discussed as belonging to one of three categories: consumer, prosumer, and professional. To illustrate these camera
types and what they can do, consider this example: A high school basketball team comes to a print business and
would like to have a poster showing their team, the team logo, and the team bus. To capture these images, you’ll
need to take a portrait of the team members, scan their logo from a decal, and take a picture of the team bus.

Point-and-shoot. Point- and-shoot cameras (Figure 2-1 A) are generally compact cameras with 3—10 megapixels,
a built-in zoom lens, and price from $100— 500. They’re made for family and travel photography. To do the nec-
essary captures for our basketball team example, you could use a point-and-shoot camera, which would probably
have enough megapixels for the capture, a zoom lens for adjusting the field of view, and even have a tripod mount
on the bottom. However, it won’t have interchangeable lenses, attachable filters, or an optical viewfinder that
accurately frames the scene.

35-mm DSLR. Digital single-lens reflex cameras (DSLRs, Figure 2-1 B) are adapted from cameras designed to

11
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shoot 24x35-mm slides and negatives. These cameras have interchangeable lenses that provide a variety of focal
lengths and applications, including zoom, wide-angle, macro, portrait, telephoto, and low-light shooting. These
cameras generally record from 6-12 or more megapixels and cost from $500 to several thousand dollars. SLRs use
a single lens that both records the image and previews the shot through the viewfinder. (Twin-lens reflex cameras
used separate lenses for the image and viewfinder.) SLRs use a mirror to deflect light from the sensor plane to the
viewfinder. During exposure, the mirror flips up to allow light to reach the sensor plane.

The 35-mm DSLR would be the ideal camera to use for our basketball team poster example. You could use a short
telephoto lens to take the team’s portrait in a studio, mount the camera to a copy stand to capture their logo from
a supplied decal, and take the camera outdoors to shoot the team bus.

Professional Cameras. These cameras (Figure 2-1 C) are made for shooting publication images as in magazines,
catalogs, posters, banners, and billboards. They are generally based on 6x6-cm medium-format cameras, shoot up
to 40+ megapixels, and can cost well over $10,000. Their large image size requires that these cameras be attached
or “tethered” to a computer to hold the image files. The main advantage of these cameras is that they can record
enough megapixels for full-page or two-page magazine covers or spreads, or for large posters or banners.

A professional camera would be overkill for our basketball team poster. The camera could do the portrait and
copy-stand captures but would be clumsy to move around the studio due to its large size and computer cables. It
would also be difficult to take outdoors to shoot the team bus. However, for shooting products from team coffee
mugs to team vehicles in the studio, its quality could not be beat.

To show some differences among cameras, the same still-life scene was shot with a point-and-shoot, a 6-MP
DLSLR, and a 10-MP DSLR camera (Figure 2-2).
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Figure 2-2. The same still-life scene was photographed with (A) a 5-MP point-and-shoot camera, (B) a 6-MP DSLR, and (C) a
10-MP DSLR. A small square in the image was then cropped to a size of 1.6 in. at 300 ppi. Differences in camera resolution are
apparent in the relative sizes of the cropped areas. Also, slight differences in color rendition are visible among the cameras.

Megapixels

Would you rather look at an image that’s sharp and detailed, or one that’s pixelized with the “jaggies”? To avoid
the jaggies, you’ll need enough megapixels for your output device and enlargement size. Digital camera image
size is measured in millions of pixels, or megapixels (MP, Figures 2-3 and 2-4). Current camera models range in
image size from a few to nearly forty megapixels. Three questions that the prepress professionals want to know
about digital cameras are:

1. Thave a digital camera. How large an image can I get from it?

2. Twant to buy a digital camera to make images of a certain size. How many megapixels do I need?
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Answering both questions requires calculating image size based on prepress parameters including screen ruling,
image sampling ratio (pixels per halftone dot), and image resolution required.
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Figure 2-3. Printed images require sufficient megapixels to support their resolution and screening. This
diagram shows the relative sizes of various megapixel images in relation to an 8.5x11-in. page (white dotted
outline), which requires 8.5 MP for full coverage.
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Figure 2-4. Relative sizes of images for the web on standard (1920x1080 21-in.), 4K (40962304, 21-in.), and 5K (5120x2880, 27-in.)
displays (compare with Table 2-1).

Calculating Megapixels Needed for Print

1. Determine the sampling ratio you want to use (e.g., 2:1 for presses, 1.5:1 or 1:1 for digital printers).

2. Calculate the pixels per inch (ppi) needed:

a. Litho: ppi = screen ruling (Ipi) x sampling ratio (e.g., 300 ppi = 150 Ipi x 2)

b. Large format: viewing distance

3. Megapixels per sq.in. = ppi2 (e.g., 3002 = 90,000 pixels = 0.09 MP)
4. Multiply MP/sq.in. by image size (e.g., for an 8x10-in. photo, 0.09 MP x 8 x 10 = 7.2 MP

Calculating Megapixels Needed for Web

1. Determine the horizontal and vertical resolution of the display (Table 2-1).

2. Multiply the horizontal and vertical resolution, then divide by 1 million to get the number of
megapixels in the display.

3. From the table you can see that a 16-MP digital camera should produce photos of adequate resolution
for a 5K display.
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Table 2-1. Megapixels for 21.5- and 27-in. iMac Displays

Display Resolution MP
iMac 21.5 in. Standard 1920%1080 2
iMac 21.5 in. 4K Retina 4096x2304 9.5
iMac 27 in. 5K Retina 5120%2880 15

Calculating the Print Image Size You Can Get from Your Camera

1. As above, determine the ppi you need, e.g. 300 ppi for print or 72 ppi for web.
2. Calculate the number of MP per sq.in. (e.g., 300 ppi2 = 90,000 pixels/sq.in. = 0.09 MP/sq.in.)

3. Divide camera MP by MP/sq.in. (0.09) to get available sq.in. (e.g., 6 MP camera + 0.09 MP/sq.in. =
66.67 sq.in. of image area).

4. Take the square root of the available image area to get image size, e.g., the square root of 66.67 sq.in.
=8.16in.

5. So a 6-MP digital camera will give you an image 8.16 % 8.16 in. at 300 ppi.

6. Convert the image size to the proportion you want, e.g., 6-MP image in the proportion of 8x10 would
be 7.3 x 9.1 in.

Lenses

Assuming you have a 35-mm or medium-format digital SLR camera, you’ll need a variety of lenses for the widest
variety of photos. Lenses are classified by their focal length, which is the distance from the lens center to the
camera’s imaging sensor. The longer the focal length, the more telescopic the lens; the shorter, the wider its angle
of view. The image sensor of a digital 35-mm SLR may not be as large as the standard 24x35-mm. This extends
the focal length of a lens by the camera’s focal length factor, which is usually specified in the owner’s manual.
For example, a digital camera with a 16x24-mm sensor will have a focal length factor of 1.5. This means that a
50-mm lens on a 35-mm film camera will have an effective focal length of 75 mm. Lenses are loosely categorized
as:

» Normal—Ilenses in the range of 40—70 mm (for a 35-mm equivalent camera), used for photographing
groups of people, products, and scenery

» Telephoto—Ilenses of 70-1,000 mm, used for bringing distant objects closer and (in the low range) for
portraits. Telephoto lenses flatten perspective (Figure 2-5, right), making subjects appear to have less
depth.

* Wide-angle—lenses of 15-40 mm, used for capturing a wider view of the scenery, architecture, and
rooms. Wide-angle lenses extend perspective, making objects appear further apart in depth (Figure
2-5, left). The widest-angle lens is the fish-eye.

» Zoom lenses—Ilenses that can change focal length over an extended range, e.g., 40—70 mm, 70-200
mm. These provide more flexibility than fixed focal-length lenses but are longer, weigh more, and
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usually have a smaller aperture compared to comparable fixed focal-length lenses.

* Macro lenses—Ilenses usually in the range of 50—100 mm that can focus very close to subjects. The
distance of closest focus can be quoted in millimeters or as the reproduction ratio, the size of the image
relative to the original subject. A 1:1 macro lens can focus close enough to capture small subjects at
the same size on the image sensor.

A7 |7
L

Wide Angle i+ Telephoto

Figure 2-5. Comparison of wide-angle and telephoto lens shots encompassing the same area. Note that the telephoto lens produces an effect
of compressing the depth.

Filters

Filters attach to the front of the lens and provide different image-enhancement effects. Filter size is quoted in
diameter (mm) and usually indicated on a lens with the symbol “@.”

» UV/Haze filter—blocks ultraviolet radiation and helps to produce sharper images of scenery during
hazy weather. Since the filter does not introduce any colored effects in photographs, it is often used to
protect the front of the lens from scratches, fingerprints, dust, and damage (Figure 2-7).

* Polarizing filter—blocks glare (white light) reflected from nonmetallic surfaces and enhances color
saturation on subjects. Often used for photographing scenery and product photography (Figure 2-7).



18 + DIGITAL PHOTOGRAPHY FOR GRAPHIC COMMUNICATIONS

+ Light-balancing filters—help neutralize various lighting conditions such as incandescent room lights,
fluorescent office lights, and outdoor shadows. These filters have been largely supplanted by the
automatic white-balance feature of digital cameras, which neutralizes the image to the light source.

» Special-effects filters—filters like cross-stars produce starburst and other effects.

* Colored filters—filters such as red, green, and blue can be used to enhance certain image colors in
black-and-white photos (Figure 2-8). For example, Ansel Adams often used a red filter to make the
sky look darker in many of his famous Yosemite photos.

Figure 2-6. UV-haze filter protects the camera’s lens and reduces some of the blurring and low contrast caused
by hazy weather.
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Figure 2-7. Comparison of shots taken with a UV haze filter (left) and polarizing filter (right). The polarizing filter eliminates reflected glare
from surfaces, increasing color saturation.

Figure 2-8. Comparison of grayscale photos taken with a polarizing filter (left) and red filter (right). The red filter darkens greens and blues
in the scene, increasing contrast.

Lighting
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For studio photography, you will need some type of lighting, in addition to the available daylight or office lighting.
Studio lighting increases the available light intensity for your photographs, enabling you to use smaller apertures
and faster shutter speeds. These, in turn, provide greater depth of field and sharper photos by minimizing the
effects of camera motion. Studio lighting also provides a controlled “color” (color temperature) of white light,
keeping your photos in consistent color balance.

Studio lights can be classified as to lighting duration and temperature. Continuous lights, such as incandescent
or mini-fluorescent lamps, provide a constant light source. Strobe lights provide a bright flash in a fraction of a
second. By shining all the time, continuous lights enable you to visualize your scene better and focus the camera,
but may not be as intense as strobes. Strobe lights, on the other hand, make it difficult to see the scene as it will be
illuminated, but provide brighter light. They also reduce motion of the subjects by providing a short burst of light.

Among continuous lights, quartz halogen incandescent and mini fluorescent lights are classified as “hot” and
“cool” lights, respectively. Hot lights are more difficult to handle due to the heat generated but are cheaper to buy
and provide more intense lighting. Cool lights remain cool to the touch so are safer to work with than hot lamps,
but do not produce as intense a light.

Reflectors and Diffusers

Studio lights act as point light sources, which can produce harsh illumination and sharp shadows. To diffuse their
light you can use a reflector or a diffuser. Reflectors, such as aluminized umbrellas (Figure 2-9, left), diffuse light
by bouncing it off of an uneven, metallized, semi-spherical surface that scatters the light. Diffusers, such as soft-
boxes (Figure 2-9, right), transmit light through a translucent cloth that scatters it.
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Figure 2-9. Studio lights with umbrella reflectors (left) or soft box diffusers (right) help illuminate still-life, product, and portrait shots with
soft, even lighting.

Stands

Tripod. To mount your camera and avoid image shake, you will need a tripod. Tripods come in two types: quick-
release and screw-on. Quick-release tripods (Figure 2-10) have a removable base plate that you can attach to the
camera, then snap into the tripod. Conventional tripods have an attached screw mount that you screw into the base
of the camera.

Light stands. Light stands are used for mounting hot and cool continuous lamps and strobe. They are not as
sturdy as a tripod but do enable the lamps to be positioned at anywhere from ground height to several feet above
the floor.

Copy stands. A copy stand (Figure 2-11) is useful for photographing flat work. Similar in concept to a process
camera used to make halftones, a copy stand has mounts to hold lights at a 45° angle from the artwork to evenly
illuminate it and avoid glare. A copy stand can also be used to hold the camera for closeup macro work.
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g

Figure 2-10. Camera attachments. A quick-release tripod mount has a detachable bracket that is screwed into the camera’s tripod mount and
then clamped to the tripod.
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Figure 2-11. A copy stand is useful for photographing flat subjects. This photo also shows an 18% gray card,
useful for setting exposure to 0 EV, and a white card, used for setting white balance. (White balance can be set
on either the gray or white cards, provided that both are colorimetrically neutral.)

QC Devices and Targets

In studio photography, quality control devices help you get the most accurate and repeatable photos. Some are
useful for outdoor photography as well.

18% Gray Card. An 18% gray card, such as the X-Rite Macbeth Gray Card (see Figure 2-11) is useful for setting
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manual exposure with the digital camera’s built-in light meter. The meter sets exposure to the midtone, the point
in between the lightest highlight and darkest shadow. If you point the meter toward a subject, that subject may
be lighter or darker than the midtone. In either case, the meter will expose it as a midtone. You can get a more
accurate and consistent exposure by using an 18% gray card as the object to be metered. Use of this device is
discussed in Chapter 5, Image Fidelity.

White-Balance Card. Most digital cameras have a white balance setting that calibrates the camera’s color balance
to the light source. To set white balance, the camera must be pointed toward a neutral gray object. You can use a
white or gray card, such as X-Rite’s Macbeth Gray Card or White Card (see Figure 2-11). These cards are neutral,
meaning they reflect an equal amount of red, green, and blue light. To check the neutrality, measure the card
with a colorimeter. The CIELAB values should have a*b* (red-green and blue-yellow) values near 0,0, indicating
neutrality. This device is also discussed in Chapter 4.

ICC Profiling Target. Studio photographs can be made with more consistent color, and color from multiple
cameras can be synchronized, by applying a custom ICC profile to the camera (see Chapter 4). To make a camera
ICC profile, you’ll need a profiling application and a color target. The most widely known color target is X-Rite’s
Macbeth ColorChecker (Figure 2-12). To make the profile, you’ll need to photograph the target squarely using
the same lighting conditions as for products or other subjects to be photographed.

Light Meter. While most digital cameras have built-in light meters that can be used to set exposure, especially
with the aid of an 18% gray card, a separate light meter (Figure 2-13) is often useful for getting accurate
exposures. You will definitely need a light meter for studio strobes, which cannot be measured by built-in camera
meters. A meter measures light that is either incident upon, or reflected from, the scene, then calculates the
exposure value (EV), or aperture/shutter speed setting to produce a properly exposed photograph.

Cable Release or Control App. A cable release or control app (Figure 2-14) can be used to trigger the camera
without touching it, reducing the chance of image blur due to camera shake.
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Figure 2-12. X-Rite MacBeth ColorChecker Mini profiling target for digital cameras.
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Figure 2-13. Light meter for measuring exposure. Virtually all of today’s cameras have built-in light meters,
however, a separate light meter can sometimes be useful for checking exposure in a specific location.
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Figure 2-14. An electronic cable release for a Pentax camera (left) and Canon’s Camera Connect app for iPhone (right), which
controls Canon WiFi-equipped cameras.
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File Formats and Applications

A digital photo or artwork could end up in a variety of digital file formats, depending upon the image itself and
whether it’s placed in a page. Within the graphic communications industry, there are literally dozens of different
image file formats that can be created, manipulated, and reproduced. Some file formats are appropriate for print
production, while others are best suited for the web and digital media. The more you know about file formats,
color spaces, resolution and compression, the greater the opportunity you will have to achieve desirable outcomes
with your digital images. In this chapter, we will explore various digital file formats and their attributes associated
with them.

File Formats

There are many different file types that a digital image could be; however, when it comes to the content of the
image, there are really only two options: vector and bitmap.

Table 3-1. Comparison of Vector and Bitmapped Files

Vector Bitmapped

diagrams, charts, synthetic artwork: photographs, Photoshop images,
Stationary type, Adobe Illustrator and CAD files, pixel-based drawings (synthetic

Photoshop paths artwork)

vector animation: HTMLS5 tags, CSS3  digital video: Apple iMovie, Adobe

Moving styles, JavaScript Premiere files

Vector Image Data

Vector images (Table 3-1) are defined mathematically as a series of points, lines, curves, and shapes, with colour
fills and strokes. Their advantage is a small file size combined with resolution independence, or the ability to be
scaled up without loss of resolution. They are used mostly for charts, diagrams, type, and synthetic artwork, or
pictures drawn on the computer. Vector graphics can be created in different color spaces, can combine process and
spot colors, contain multicolor vignettes, and even support transparency in some instances. A disadvantage is the
lack of realism that comes with photos. Examples are Adobe Illustrator files, Photoshop paths, and type faces.

27
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Animations can also be vector graphics in the form of HTML tags and accompanying CSS styles and JavaScript
interactivity.

Figure 3-1. Fonts are just one example of vector-based design. This figure shows the relationship of points and
Bezier curves that make up the mathematical representation of the object. Note that the path between points
can be straight or curved.

Bitmapped Image Data

A bitmap is often compared with a mosaic because it consists of a matrix of microscopic squares that contain tone
and colour information to reproduce a photo. Bitmapped images are end-use dependent, meaning the resolution
must be set for the desired output, including type of page and reproduction size.

Resolution for Web. The proper resolution for a bitmap image is dependent on the end-use of the image, as well
as the scale at which it is to be used. For digital applications, such as websites and interactive CD-ROMs, the
image resolution does not have to exceed 72 dpi (dots per inch) at the size it is being viewed at. The reason for
this is that conventional computer monitors display information and 72 pixels per inch maximum.

Resolution for Print. To determine optimal resolution for printing, a simple formula can be applied. This formula
will defend against undesirable effects of images with inadequate resolution. This formula takes into account a
phenomenon known as the two times rule. The rule states that in order for a bitmap image to give the illusion of a
continuous tone image, there must be twice the resolution in the image than the printing linescreen on press, when
the image is at its final size. If the image has less than two pixels for every printing dot, the individual pixels will
become evident to the observer. The formula for this equation is as follows:

R =2 xIpi x sf
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where: R = resolution, Ipi = lines per inch, sf = scaling factor

For example, let’s say you have a digital image that is 72 dpi, and you would like to place this image into a layout
at 67% of its original size. The layout is for a brochure that will be printed at 150 Ipi. Will the resolution of the
image be sufficient? The above formula can be used to determine what resolution would result in an adequate
final resolution:

R =2 x 150 Ipi x 0.67 = 200 ppi

For example, let’s say you have a digital image that is 72 dpi, and you would like to place this image into a layout
at 67% of its original size. The layout is for a brochure that will be printed at 150 Ipi. Will the resolution of the
image be sufficient? The above formula can be used to determine what resolution would result in an adequate
final resolution. According to the equation, the image should be 200 ppi in resolution but is actually 107 ppi (72
ppi + 0.67 scaling factor).

This model works well for conventional halftone screening. For FM (Stochastic) screening, it generally
recommended to use a higher resolution. For example, some printers using a 10 micron FM dot recommend a
minimum of 600 dpi for images.
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Figure 3-2. The image on the left has been placed at 100% of size, and has a resolution that is appropriate for
printing. The image on the right has been enlarged 800%, effectively lowering the resolution, resulting in a
pixilated image.

Image File Formats

Bitmap and vector files can be saved in a variety of different file formats. Each file format typically will be
optimized for a specific end-use or file type. For example, the bitmap file format GIF (Graphic Interchange
Format) is ideal for the World Wide Web, but should never be used for commercial printing. Other file formats
are more flexible, and could be used for a variety of end uses. Adobe’s PDF (Portable Document Format) can be
optimized for electronic distribution or high-end commercial printing, depending on the quality settings used to
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create the PDF. Vector images can only be saved in a limited number file formats without being converted into

bitmap format. For a summary of various image file formats and uses (Table 3-2).

Table 3-2. File Formats and Uses

File Format Image Type Description
Native Formats
Adobe Vector Native application file. Can be imported natively in Adobe InDesign or exported as
Mlustrator (.ai) SVG and other formats for web.
Native full megapixel, high-resolution camera images. Must be saved in standard
Camera Raw . £ f S - = . . f
(incl. DNG) Bitmap ormats for use in print and web. DNG is Adobe’s Digital Negative universal format
) for camera raw.
Hi-res file format that can contain any combination of vector or bitmap data.
Photoshop . PhotoShop files are often used to save “working” files for image manipulation. They
Vector, bitmap, : . .
Document or both can contain layers, effects, and extra channels. Photoshop files can be placed natively
(-psd) into InDesign, but must be saved as another file format to be used in other
applications, such as TIFF and JPEG for print and JPEG, PNG, or GIF for web.
For Print and Web

Bitmap File

Low-res RGB file format common on the Windows operating system. Suitable for

(.bmp) T screen-based applications such as the Internet, PowerPoint, etc.
Joint Jpegs are compressed images. Jpeg compression is lossy, so it affects the quality of
Photographic Bitmap the image. Too much compression will create artifacts in the image that will show in

Experts Group
(:jpg)

print or on screen. Lo-res to hi-res application, depending on resolution and
compression level.

Hi-res file format that can contain any combination of vector or bitmap data. PDF

Portable Vector. bitma files are ideal for document distribution because they are platform independent, and
Document or botl’1 P> can contain multiple pages. The quality and file size of a PDF can be affected by a
Format (.pdf) number of settings. For print PDF can be imported as a graphic into InDesign; on the
web it will display as separate pages in most browsers.

For Print
Encapsulated Vector. bitma Hi-res file format that can contain any combination of vector or bitmap data. A

pst ’ P> variation of EPS (EPS DCS) can be used to maintain spot channels in PhotoShop
PostScript (.eps) or both files
Tagged Image Hi-res commercial printing application. Tiff files typically do not have the flexibility
File Format Bitmap and features of EPS files, but result in a smaller finished file size, which makes them
(.tif) more efficient.
For Web
Graphics Lo-res file type created for use with the Internet. Gif files are very small in file size
Interchange Bitmap due to the fact that they use index color and have a limited color palette. Gif files are
Format (.gif) best used for illustration-type images as opposed to photographs.
Portable Lo-res Internet-based applications. PNG was created to replace GIF files. They can
Network Bitmap be RGB, and are more flexible than GIF files. PNG files employ lossless
Graphics (.png) compression and can use 8-bit or 24-bit colour.
Scalable Vector Vector Vector format for the web, can be exported from Adobe Illustrator and other vector

Graphic (.svg)

graphic programs.
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File Formats and Workflow

Resolution for Print
(ppi 2x screen ruling)
Camera raw file > Working Image

(maximum resolution) File Resolution for Web
(72 ppi)

Figure 3-3. Image workflow logically starts with images at the camera’s maximum resolution and in camera
raw format. Files can then be saved for working with a bitmapped image-editing program and then resolution
set for print and/or web.

Most digital cameras can capture images in uncompressed native, or camera raw, format, or in several different
sizes and quality levels of JPEG-compressed images. Some photographers prefer to save JPEG images because
processing is faster, but they may lose some of the available resolution and image tonal data. With the fast
microprocessors and solid state drives on today’s computers, camera raw processing has become a lot faster than
in years past.

Each camera manufacturer and camera model has its own proprietary format of camera raw. To open the files
on a computer, the software publisher needs to write a conversion algorithm from the camera’s raw format to a
standard file format. A universal camera raw format is Adobe Digital Negative, or DNG.

Camera raw files are like the digital equivalent to a traditional film negative — they contain all the data captured
by the camera, but they are not processed into final images. This means that camera raw files are not restricted
to any process parameters and remain extremely flexible in how they are “digitally developed.” Camera raw files
have the greatest ability to match (or improve upon) the original scene.

Like traditional negatives, Camera Raw files must be post-processed in order to be representative of the target
scene. There are two processes that must be performed to a Camera Raw file before it can be used in a print
application. First, the image must be demosaiced. This process maps the monochromatic data captured by the
camera’s CCD array and translates it into RGB data. The second process is rendering. This is where the RGB data
is enhanced to create an image that attempts to represent “pleasing color.”

Since bitmapped image files are end-use dependent, a logical starting point with a DSLR camera would be to
capture camera raw (Figure 3-1). Raw files need to be converted to standard file formats (e.g., TIFF, JPEG, PSD),
without loss of resolution, for processing (Figure 3-1, “Working Image File”). Different resolutions are required
for web, print, eBooks, and other forms of output. So the working image file can be saved in the appropriate
format, using for example Photoshop’s Save for Web or Export As functions.

Placing Photos in Pages
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Print Pages

Images can be placed in pages for print or web, including apps. Different programs, languages, and image file
formats are suitable for each application (Table 3-3).

Table 3-3. Page Layout Applications

Type of S ; Colour

page Example applications Image file types mode Transparency
Print Adobe InDesign, QuarkXPress, Microsoft Word, Google  TIFF, JPEG RGB or

Page Docs, other apps (high-quality) CMYK

gﬁ; HTML, CSS, JavaScript; Adobe Dreamweaver, text editor JPEG, PNG, GIF RGB PNG, GIF

For print, page layout applications like Adobe InDesign and QuarkXPress can combine vector and bitmap images
with text, then save pages in native or standard formats like Adobe PDF. Because these programs are meant
to handle large amount of information, they have numerous tools to maximize productivity and efficiency. For
example, they can automatically create a table of contents, generate indexes, create master page designs, organize
multiple documents into one project, and even synchronize documents to each other.

Page layout programs offer greater flexibility than a word processor when it comes to importing and placing
images, including enhanced text-wrapping features and the ability to support clipping paths. Users can place
images in picture boxes and text in text boxes, then set type to wrap around the images (Figure 3-4).

Although these programs are well suited for merging images and illustrations on the same page, they are not
image editors. If you want to edit an image that is used in a page layout program, you must open it up in the
appropriate alternative program (e.g. Illustrator for vector art or Photoshop for bitmaps).
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Web Pages

Web pages are constructed using tags like <p> for paragraphs, <h1> for headings, and <img> for images (Figure
3-5). The tags create objects that can be styled using cascading style sheets (CSS) to specify size, positioning,
colour, and other attributes, and JavaScript to add interactivity. HTML, CSS, and JavaScript can be written with a
free text editor like TextWrangler, Atom, or SublimeText and previewed in a browser. Purpose-specific programs

DIGITAL PHOTOGRAPHY FOR GRAPHIC COMMUNICATIONS

Chinese paper cutting, or Sianxi, was

the first type of artistic paper cutting
developed since the time paper was
invented during the Han Dynasty. Sianxi
has been practiced in China since at
least the 6th century AD. Because the

1 cut outs are used to decorate doors and

windows, they are sometimes referred to
as “window flowers” Common subjects
include flowers, birds and other animals,
Chinese characters, and symbols of luck.
(Written with reference to Wikipedia, The
Free Encyclopedia, enwikipedia.org.)

Figure 3-4. Example of a print page layout in Adobe InDesign.

like Adobe Dreamweaver offer additional tools and preview capability.
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Images for web should generally be 72 ppi resolution, RGB colour mode, and set to final size, rather than being
resized with the “width” style. Achieving the smallest possible file size makes pages load faster and helps retain
readers’ attention.

A possible source of confusion for print designers learning about the web is that HTML does not have a fixed
page size and does not utilize text boxes and picture boxes. Rather, text placed in a <p> paragraph tag can be
styled to have a certain width and position on the page. Images can either be placed on separate lines or have text
wrapped around them using the “float: left” or “float: right” styles.

Home Page 2

hinese paper cutting, or Sianxi, was the first

type of artistic paper cutting developed since

the time paper was invented during the Han
Dynasty. Sianxi has been practiced in China since at
least the 6th century AD. Because the cut outs are used
to decorate doors and windows, they are sometimes
referred to as “window flowers.” Common subjects
include flowers, birds and other animals, Chinese
characters, and symbols of luck.

This example of a Sianxi paper cut shows a
finch with colourful flowers.

Figure 3-5. Example of a web page with an image and text wrap created with the “float” style.



Chapter 4 * Color Management (Reem)

How can you get consistent color from camera to monitor to print? Shouldn’t color match by itself? The advent
of desktop publishing in the 1990s enabled users to connect various “plug-and-play” color peripherals, including
cameras, monitors, and printers. Although standards have helped create uniform color, one device does not
necessarily “know” about the others or the way they save, show, or print color.

One standard that has helped overcome device color differences is the International Color Consortium (ICC)
profile format, which characterizes devices by relating their color to a mathematical model of human vision.
Colour profiling is a great solution to the quest for closely-matching color but can be a challenge to set up.

The purpose of this chapter is to help users understand the concepts behind color management. To implement a
system, help will undoubtedly be required from systems and peripherals vendors.

ICC profiles capture the color reproduction characteristics of each device using an industry-standard file format
for both Windows and Macintosh computers (Figure 4-1). These profiles can be read by ICC-compatible photo-
editing, illustration, page-layout, web-design, and web-browsing programs as well as the drivers and raster image
processors (RIPs) that control printers.

When considering workflow, keep in mind that the goals of using color management in a digital workflow are to
have:

* accurate, consistent color from the original scene, photographic print, or transparency to final output
(printed or displayed).

* accurate monitor previews of the original file, final output, or proof.

 proofs that simulate press sheets or production printers.

36
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= Scanner Profile
= Adobe RGB
- sRGB

SWOP Press

RGB

Figure 4-1. Standard Working Spaces. These diagrams in the CIE xyY chromaticity diagram compare the
color gamuts of Adobe RGB and sRGB standard RGB working spaces with those of a color scanner (could
also be a digital camera) and a web offset printing press such as would be used to print magazines and
catalogs.

The Source-Destination-Simulation Model
The above workflow objectives are facilitated by four types of ICC profiles:

* source profile—This profile describes the color space in which the image was created or currently
exists—generally a scanner or camera profile. It could also be a standard working space profile.
Ideally, all images with a scanner or camera profile should be converted to a standard working space,
and the standard working space profile should be embedded into files, so users can identify it down the
line. If you or your customer don’t know what standard working space was used, you won’t be able to
get matching color.

* standard working space profile—A standard working space is a place to store data until you know
what you want to do with it (display, proof, print, or archive it). Adobe Photoshop and other
applications support several standard RGB working spaces, including (from largest to smallest) Adobe
RGB, ColorMatch RGB, and sRGB. Most content creators today use the largest, Adobe RGB. Users
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with CMYK workflows can use one of Adobe’s standard CMYK working spaces, such as U.S.
Sheetfed Coated or U.S. Web Coated (SWOP). Of these Sheetfed Coated has the larger gamut, but
SWOP is more common. SWOP (Specifications for Web Offset Publications) was the first color
specification developed.

* destination profile—This profile describes the device or process to which the file will be output. The
destination could be a color monitor (for display), an inkjet printer (for proofing), or a production
printer (for final output).

» simulation profile—This profile describes the device or process that the image should look like when
proofed. When proofed on a small inkjet printer, for example, the simulation profile would be that of
the production printer.

The role of the four profile types can be seen in the workflow illustrated in Figure 4-2. To follow the workflow,

think of color image files as “on the move” from a source (e.g., camera, file) to a destination (monitor, printer,

proofer). Each step is represented by a profile. “Assigning” profiles to a file indicates what device it came from,

while “converting” changes the color to match on an output device.

MONITOR
PROFILE

AUTOMATIC
CONVERSION

ASSIGN

CAMERA, SCANNER PRINTER
PROFILE PROFILE

Figure 4-2. Workflow illustrating the source-destination-simulation color model. A digital camera file (A) can be converted from a digital
camera profile (DCP) to a standard working space profile (represented by the CDs), then converted for output to a monitor profile for display
(B), a proofer with simulation of the final output, and a printer (C).

Let's Start with the File . ..
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To use color management effectively in a workflow, the standard file types (TIFF, JPG, PDF, EPS, etc.) you’re
printing should be in one of the industry-standard color working spaces, such as Adobe RGB, sRGB, or SWOP
CMYK (Figure 4-3). A standard working space is an ICC profile that has been standardized and is the same for
all ICC-compatible applications. It is a place to store color data until you know what you want to do with it, such
as print it or display it.

Color Management

Use embedded profiles, if available
Use dynamic rendering intent

Source profiles
RGE: AdobeRGE1998.icc B
Rendering intent: Perceptual H
CMYK: GRACoL2013_CRPCH.icc E
Rendering intent: Absolute colorimetric (paper white) E
Grayscale: EFl Gray Profile Linear.icc ﬁ
Rendering intent: Relative colorimetric {no paper white) B
Multicolor: None v
Rendering intent: Relative colorimetric (no paper white) H
L*z*h* labltol.icc H
Rendering intent: Absolute colorimetric (paper white) H
Simulation profile

Figure 4-3. A standard working space profile is the starting point for a good
color-managed workflow. This profile acts like a nametag for the file, identifying its
color space for proper matching. This example shows an EFI Fiery RIP’s setting

for default input profile. This profile is assigned to images that don’t have an
embedded ICC profile.

You will need to choose whether to use an RGB or CMYK working space (see Figure 4-1). RGB working spaces
generally provide larger color gamuts than CMYK. They give the greatest color saturation or “pop.” Customers
may submit files in CMYK, though. In either case, the standard working space profile should be embedded in the
image. Embedding the profile doesn’t add much to the file size, and it enables anyone who receives the file to
match the color on output or display, as long as they have an accurate output profile.

If the standard working space profile isn’t embedded in the image, most workflow applications enable you to
specify a default source profile (see Figure 4-3). If a customer submits a file without an embedded standard
working space profile and you don’t know what profile they used, it’s best to contact the customer and ask.
Otherwise, you’ll have to choose a profile and the color may not match the customer’s expectations.
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Where Did the File Come From?

Photos to be printed may have been scanned, captured with a digital camera, or licensed from an image bank.
Image bank photos should have an embedded standard working space profile. To properly start a color-managed
workflow, scans and captures should be done with a profiled scanner or camera. If the driver supports ICC
profiles, you’ll be able to assign the profile to images or convert them to a standard working space upon saving. If
your scanner or camera driver doesn’t support ICC profiles, you can still profile the device, then assign the profile
in Photoshop using the command Edit > Assign Profile (Figure 4-4). (Assign indicates the color space where the
image came from, or its source; versus Convert to, which indicates where it’s going, or being output.)

Assign Profile

Assign Profile:

Don't Color Manage This Document
Cancel

© Working RGB: sRGB IEC61966-2.1

Profile: = Adobe RGB (1998) Preview

Figure 4-4. Photoshop’s Edit > Assign profile can be used to identify the source profile of a scanned or
digitally-photographed image if the scanner or camera driver doesn’t support input profiles.

To streamline your workflow, convert all images from the scanner or camera input profile to a standard working
space profile. This places all of your images in the same color space. An exception might be for fine-art
photographers or anyone who handles all files in-house and wants extreme color accuracy. These users may want
to avoid the slight inaccuracy of an additional color conversion by leaving images in the color space of the
scanner or camera profile. As long as the profile is embedded in the image, the RIP will
be able to read it and use it for color matching.

Where is the File Going?

When printed, files will be output to a printer using an application RIP. ICC-compatible RIPs enable the selection
of an output profile (Figure 4-5). This profile will be specific to the printer, ink, paper or media, and RIP settings
(such as resolution and dot pattern). Selecting the proper printer profile ensures that your images will match the
original file as closely as possible. Using a printer profile alone does not guarantee a match to the monitor, but
rather to the original file.

L*a*b* optimization:
ESPP240_PO000V_Dec2017 M1 CT.3cc E

Crnt ralar nntimizatinn:
Figure 4-5. Software RIPs, such as EFI Fiery, used with large-format inkjet printers

and computer-to-plate platesetters enable selection of an output profile that
characterizes its print characteristics.

Soft Proofing
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Before printing images, you may wish to preview them on the monitor. Soft proofing can be done in an ICC-
compatible application or RIP. Most RIPs support color-managed monitors for accurate previewing. To accurately
preview files on the monitor, you will need to have a calibrated monitor and monitor profile. If the RIP supports
monitor profiles, it will convert color from the standard working space profile to the monitor profile. This shows
that “what you see is what’s in the file” (WYSIWIF). If the RIP supports soft proofing, it will convert color from
the standard working space to the monitor profile, using the printer profile as a reference or “simulation” profile
(Figure 4-6).

Simulation profile

Use PDF output intent, if available

Simulation profile: CRACoL2013_CRPCE.icc d

Rendering intent: Absolute colorimetric (paper white) d

Figure 4-6. Simulation profile in EFI’s Fiery RIP. The simulation profile enables an
inkjet proofer to print color that looks like it came from a lithographic press printing
to GRACoL specifications. (GRACoL stands for General Requirements in
Applications of Commercial Offset Lithography.)

Printing with Profiles

If you use a digital camera, chances are you may print images using a large-format inkjet printer. These printers
have become many photographers’ “digital darkrooms.” Inkjet printers typically work with computer based raster
image processors known as software RIPs. A raster image processor (RIP) converts files from vector- and/or
bitmapped format into a device-specific bitmap that controls the imaging of inkjet ink spots, image carrier halftone
dots, or other output reproduction imaging processes.

Many RIPs used in large-format inkjet printing can be used to print individual graphics directly from files. For
document production, it is more common to print to a RIP from an application.

Printing Directly from a RIP with Colour Management. When printing files by opening them in a RIP, the
files should have an embedded source profile, or the profile should be identified in the RIP as the default source
profile. Choose the correct output profile for the media, ink, printer, and settings (SeeFigures 4-3 and 4-5).

Printing from Applications with RIP Colour Management. When printing to a RIP from applications, there are
three places to set color management profiles: the application, the RIP, and ICM (Windows) or ColorSync (Apple).
Only one conversion should be set to avoid multiple color transformations. To print a file from an application
using RIP color management, ensure that the file is in a standard working space, as would a file that is to be
printed directly from the RIP. In the application, set the output profile to “Printer Manages Color,” as shown in
Photoshop (Figure 4-7) as an example. This will transmit the file to the RIP with color unchanged, saving the
color conversion for the RIP. Second, your RIP may create a Windows printer for each device you use. Windows
printers have settings for Microsoft’s Integrated Color Management (ICM). If activated, the ICM settings could
cause a double color conversion. To avoid this, set Windows ICM to “Application Managed Colors” or “ICM
Disabled.”
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@ Photoshop Print Settings
21.59 cm x 27.94 cm Printer Setup

Printer: HP750 HEI301 - 141.117.251.74

Copies: 1 Print Settings...

Layout: EY i

v Color Management

Remember to enable the printer’s color
management in the print settings dialog box.

Document Profile: SRGB IEC61966-2.1

Color Handling: = Printer Manages Colors

Printer Profile:

Normal Printing ~

Rendering Intent:  Perceptual

E
g
¢
d

v Deaerrintinn

Figure 4-7. When printing to a RIP from an application, turn off color management in the application by selecting (in this example with
Photoshop) “Printer Manages Colors.” This passes the file unchanged to the RIP, where color conversion for accurate output matching takes
place.

Printing from Applications without RIP Colour Management. ICC-compatible applications can print with
color matching by converting images from the standard working space profile to the printer profile. Using
Photoshop as an example, in the Print dialog box, select Color Handling > Photoshop Manages Colors and Printer
Profile > [select the ICC profile for the printer]. To print to a proofer with simulation of a final output device,
change Normal Printing to Hard Proofing. Select the proofer profile in the Printer Profile popup and select the
device to simulate in the Hard Proofing > Proof Setup popup.

RGB and CMYK Workflows

Apple Computer discusses different graphics workflows to use with ColorSync (www.apple.com/colorsync).
They coined the terms “late-binding” and “early-binding” workflow, referring to the point where you “bind,” or
commit, files to the color gamut of the printer (Figure 4-8).

Late-binding workflow captures, edits, and submits files in RGB mode. The service provider then converts files
to CMYK using a printer profile. The advantage is that it preserves images’ maximum color gamut until output.
This is helpful in getting the best color on different printers, and in repurposing output from print to web or CD or
cross-media publication.

Early-binding workflow captures images in CMYK, either directly from the scanner or camera, or by converting
in Photoshop to a CMYK standard working space profile or printer profile. Its advantage is that editing is done in
the printer’s profile, so that the preview more closely approximates the printed image.
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LATE-BINDING AND EARLY-BINDING WORKFLOWS

Input CMYK Working SPC‘% Output to Press

—
Input RGB Working Space Output to Multiple Devices

Figure 4-8. Early-binding (red) and late-binding (purple) workflows differ as to the point in time when the color gamut of files is bound to
that of the final output device or process. Late-binding workflow keeps documents in standard color working space, preserving the maximum
color gamut until converting them to the output device profile at the time of printing. Early-binding workflow converts files to the color
gamut of the output device as soon as possible after capture.

Colour Rendering Intent

Because various imaging devices—scanners, cameras, monitors, and printers—work in different ways, they may
not be able to create the identical range of colors. One reason users are sometimes disappointed in color output is
gamut limitations. The gamut is the range of colors reproducible by a device. A device’s color gamut is recorded
in its profile. RGB-type devices, such as scanners, cameras, and monitors, generally have larger color gamuts than
CMYK devices, which include most printers. The main reason is that RGB devices create color with light, while
CMYK devices create color with ink on paper.

As images are passed into and out of the profile connection space for “matching,” they may be sent to a device
with a smaller color gamut. In such cases, color management must deal with out-of-gamut colors.

Color rendering attempts to find replacements for colors that cannot be printed. The ICC recognizes four standard
color rendering intents: perceptual, relative colorimetric, absolute colorimetric, and saturation.

All rendering intents move out-of-gamut colors inside the gamut of the output device. Perceptual rendering scales
in-gamut colors to “make room” for out-of-gamut colors. This is more likely to alter colors in the original, but
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preserves the distinction between colors. Perceptual rendering is used for photographs, which generally contain a
wide variety of colors and a variety of gradations (Figure 4-9, pencils photo).

Colorimetric rendering does not scale in-gamut colors. Thus an out-of-gamut color may be rendered to the same
value as an in-gamut color, so that the two colors will no longer be distinguishable. Colorimetric rendering is used
for files that contain relatively few and solid colors, such as logos or PANTONE® colors (Figure 4-9, Ryerson
logo). Absolute colorimetric rendering does not scale the white point of the file, while relative colorimetric
rendering does.

Saturation rendering makes images more colorful by moving in-gamut colors to more saturated values. Saturation

rendering is used mostly for business graphics, where an impact is more important than color accuracy (Figure
4-9, graph).

Ryerson
University

4
Regional Sales Figures 2

Figure 4-9. Various types of graphics require different color rendering intents to deal with out-of-gamut colors. These include perceptual
rendering for photos, colorimetric rendering for logos and spot colors, and saturation rendering for business graphics.

Making Profiles

Camera Profile

A digital camera profile (DCP) can be used in shooting camera raw to get a closer match to an original object
or scene. X-Rite’s free ColorChecker Passport application takes a camera raw capture in DNG format of the
MacBeth ColorChecker 24-patch target and creates a DCP profile that can be selected in Photoshop’s Camera
Raw plugin > Camera Calibration tab. It should be noted that a DCP profile is not an ICC profile as it is more
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tricky and only useful for specific applications such as fine-art photography, where accurate color matching is a
must and digital images are captured in a controllable and consistent environment. (DNG, or Digital Negative, is
Adobe’s universal raw format. Proprietary formats like Nikon NEF, Canon CR2, Sony ARW, and others can be
converted to DNG with Adobe’s free Digital Negative Converter software.).

1. Set the camera to capture camera raw.

2. Set exposure (ISO sensitivity, lens aperture, and shutter speed) and white balance using an 85% gray
card.

3. Capture a 24-patch MacBeth ColorChecker target and save in DNG format by selecting this format in
the camera’s settings (if available) or using Adobe Digital Negative Converter.

4. Drag-and-drop the DNG file of the ColorChecker target into the ColorChecker Passport interface,
name the profile, and save.

5. To check the quality of the profile, open the ColorChecker target file in Photoshop, select Camera
Calibration in the Camera Raw plugin, and select the profile you made. Note the difference in color
(Figure 4-10).

NO PROFILE DCP PROFILE

Figure 4-10. Photo with (right) and without (left) a digital camera profile.

Monitor Profile

A monitor profile ensures that the on-screen display matches the color of the original file as closely as possible.
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Depending upon the operating system, a monitor profile may be set automatically or, if not, may be chosen in
the display settings or preferences. The monitor profile should not be used as a standard working space profile
because the standard profile should be one that everyone has access to. Making a monitor profile requires a color
measurement instrument capable of measuring emitted color, and a compatible profiling application. Figure 4-11
shows an X-Rite i1 Pro instrument in the process of calibrating a monitor and making an ICC profile. Before
making a monitor profile you will have to choose a quantitative contrast level, known as gamma (usually 1.80 or
2.20, higher is more contrast), and white point, or grey level (usually 50006500 K, higher is bluer).

Mac302 08

Figure 4-11. A monitor profile being made with an X-Rite i1 Pro 2 emissive/reflective instrument and i1 Profiler software.

Printer Profile

Making a printer profile requires an instrument that can read reflective color, along with a compatible application.
Semi-automated and automated instruments make it easier to read the hundreds of color patches necessary to
characterize a printer. Instruments like the X-Rite i1 Pro (Figure 4-12) scan rows of patches and require the
operator to move the instrument from row to row. These instruments are referred to as x-scanning or semi-
automated. Instruments like the X-Rite iSis (Figure 4-13) that read an entire printed target autonomously
are called x/y-scanning or fully-automated.To make a printer profile, first print a color test chart with color
management turned off (Figure 4-14). Then read the chart with an instrument and compatible profiling application
and save the profile.
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Figure 4-12. A printer profile is made with X-Rite i1 Pro, or hand-held, instrument. Using the plastic mounting base, the operator
will manually move the instrument across the color patches row then move it to the next row to continue scanning the test target.

o= \EO 1% wl-1N

e

Figure 4-13. A printer profile is made with an i1 iSis x/y-scanning, or fully-automated, instrument. The
instrument reads the set of 800 patches unattended in about 4 min.
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Print

Printer: | HPColorLaserJetM750_PremedialLab

Presets: | Default Settings

Copies: |1 Two-Sided
Pages: © All
From: |1 to: (1
Paper Size: US Letter E 216 by 279 mm
Orientation: I *}' T!*_ Scale: | 100%
Color/Quality E

HP EasyColor
Print Color as Gray

RGB Color: Default (SRGB) .l
CMYK Colog"aiv[= el eV Ve €
SWOP
Edge Contro  pyroscale ’

¢ Advanced DIC
| Custom Profile

? F‘DFE Hide Details . Low Toner Cancel m

Figure 4-14. When printing a color test chart for printer profiling, be sure to turn off color management in the
print driver or RIP. In this case printing to an HP color laser printer, the CMYK color has been set to “Default
CMYKH+,” which is the largest color gamut of which the printer is capable of reproducing. Other settings
emulate North American, European, and Japanese printing specifications and would not be as colorful.

Summary

The graphic arts are notorious for being concerned with color and not dealing with it properly at the same time.
Because of the number of devices and color modes that a file goes through, a system needs to be implemented to
keep color accurate and consistent. ICC profiles are industry standard files for capturing color information about a
file. Essentially, when done properly what you typically first preview on a computer screen, will be similar to what
you achieve with the final print. In print production, we are moving from a larger (RGB) to a smaller (CMYK)
color gamut. Seeing that the gamut is being limited downstream, the result is usually less pleasing color in the
final print (less saturated). Often we choose to either stay in RGB for as long as possible to have more colors to
play with or immediately move to CMYK to better represent the end results. Either way, ICC profiles work to
mimic the images final output so that color is more predictable.
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Publishers who want “critical” or “match colour” want the closest possible match to the original. Think of a high-
quality magazine cover with a still life with flowers, food, and household products. The same criteria could apply
to an individual product in an online or print catalog, a portrait, a fine-art reproduction—anywhere accurate colour
is required.

Colour accuracy has an obvious impact on consumer satisfaction. If colour the colour is not striking enough then
consumers may not be attracted to the product. And if the product looks better in the photo than in real life,
consumers may be dissatisfied and return it or leave poor reviews.

For achieving critical colour, the authors suggest the following steps.

Exposure

If the old axiom, “garbage in, garbage out” is true, then a good photo starts with proper camera setup.

1. Set up the digital camera with the proper exposure and white balance, as described in Chapter
3.

2. For copy work, place a grayscale target next to the original for later use in setting highlight,
shadow, midtone, and gray balance (described in Editing below).

3. Bracket exposures +1/3 or 1/2 exposure value (EV) to provide a range from bright to dim.

4. Check the histogram on the digital camera’s screen or in the image-editing software to make
sure no tones have been cut off (Figure 5-1).

5. Look at the bracketed exposures on the big screen and choose the one with the best looking
tone and colour.
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Figure 5-1. Photo of a high-key subject (yellow orchid) with histogram visible in the digital camera display.
The histogram should show that no tones have been cut off in the capture.

Editing

The advent of colour scanners in the early 1980s enabled printers to make colour separations in a few minutes
rather than the few hours required to make them in an enlarger. At that time system vendors and research

associations developed a procedure for making the best separation on the first scan: set the contrast of the scan to
the range available with the ink and paper.

Scanner operators were taught that lithographic presses could reproduce a “smallest printable dot” of 3% dot area

before dots would “blow out” or fail to image, and a “largest printable dot” of 97% before shadow dots would
“fill in” or blend together—in both cases losing image detail.

Scanner operators also attached a grayscale, a small target with a stepped or continuous series of tones, for use in
setting the highlight, shadow, and midtone on originals (Figure 5-2).
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Figure 5-2. Copy photo with a grayscale included with the subject for

later use in setting highlight, midtone, shadow, and gray balance.

You can apply the same strategy today by setting the
highlight dot to 3% on the CMYK scale or 247 levels
(3% of 255, where level 255 is white) and shadow to
97% (8 levels, where level 0 is black).

Separators also set the midtone, or midpoint, of the
reproduction according to the original’s “key,” or
predominant brightness level. They realized that high-
key, or mostly bright, photos need more highlight
contrast and adjusted the midtone to increase contrast
in the highlights, at the expense of shadows (Figure
5-3). Likewise, predominantly dark, or low-key,
photos needed more shadow contrast.

Image courtesy of Pixabay.com.)

levels.

for low-key images.

7. Set lightest density of photo to 3% CMYK or 247

8. Set darkest density of photo to 97% CMYK or 8 levels.

9. Adjust midtone to give more highlight contrast for high-key images or more shadow contrast

Figure 5-3. Original photo (left) and edited photo with midtone
adjusted for greater highlight contrast, evident in the yellow orchid
flowers. Note that shadow contrast in the fern leaves has been
reduced.

Colour Correction

Gray Balance

Gray balance (sometimes called white balance)
ensures that neutral colours are neutral and free from
colour casts. A colour cast is a shift toward a particular
colour, as might be referred to as a reddish cast or
yellowish cast.

To set gray balance, use a gray balance tool in your
image-editing software. Set the tool to reproduce
neutral gray, which on screens is levels 127 127 127
(half of 255). CMY printing requires slightly higher
cyan, e.g., 60% 50% 50%.

Early scanner operators understood that viewers could be especially critical of reds, greens, and blues in

pictures—e.g., fire-engine red, grass green, sky blue—and termed these memory colours. The operator could

adjust the hue of a memory colour by altering the balance of CMY colours. E.g., increase yellow for a warmer red

or increase magenta for a cooler red.
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Likewise the operator could make the colours more or less saturated by reducing the amount of “unwanted” or

opposite colour. In this example, red is printed with magenta and yellow but also contains its opposite, cyan, to
add detail and create realistic saturation.

To conclude our quality checklist:

1. Set gray balance to RGB 127 127 127 levels or CMY 60 50 50% on a neutral gray object or
grayscale in the photo.

2. Check memory colours red, green, and blue for proper hue and saturation.
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Working with Printers, Web, and eBook Publishers

In this chapter, we assume you took some great photos with a DSLR camera or even your smartphone and you
want to print and/or place them on the web or in an eBook. For this purpose, we created five “personas,” or
characterizations of users, and what they want from images that are reproduced in print, on the web, and in eBooks

(Table 6-1).
Table 6-1. Examples of Photo Users
user what they want file format colour mode
home inkjet, laser colour that matches screen
with RGB driver resolution for US Letter paper LIESIE, 2BIC: G
professional inkjet colour that matches screen RGB
. proof that matches litho press TIFF, JPEG-Hi (convert CMYK
willn CLINACIIE resolution for poster, banner in RIP)
RGB
lithography colour that matches screen and/or proof TIFF, JPEG-Hi (convert CMYK
in RIP)
web good resolution JPEG, PNG, GIF RGB
fast download time
good resolution
eBook fast display time JPEG, PNG, GIF RGB

small file size

Image Capture for Print and Web

Advanced-amateur and professional point-and-shoot and DSLR cameras can generally capture camera raw and
several quality levels of compressed JPEG photos (e.g., high, medium, low). For capturing high-quality photos
for reproduction, the authors recommend capturing in camera raw, which gives the highest resolution and tonal

range available from the camera.
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Camera raw photos cannot be placed in page layouts for print or on the web. They must first be converted to
a standard file format like TIFF, JPEG, or PNG. If you are using the image format JPEG make sure to use the
“High Quality” or “Highest Quality” setting. These settings use minimal compression, allowing to keep as much
image information as possible. The TIFF file format is usually used for professional image reproduction using
print processes like lithography and/or flexography. On the Web or for electronic publishing the JPEG or PNG file
format is usually used.

Problems Facing Photos for Reproduction

In discussing how to prepare photos for print, users should keep in mind certain problems or challenges that occur
when digital images are translated from RGB to CMYK mode for reproduction on paper and also when RGB
images are displayed in eBooks and on the web.

Gamut compression. The first problem is that digital photos can contain more colours than can be reproduced
with process-colour inks on paper, which is known as gamut compression (Figure 6-1). This often results in
disappointed users: they saw a very colourful photo on-screen and are disappointed it lost some of its colour in
print. In some cases, it’s possible to preview the colour, if you have an ICC profile for the printer and a program
like Photoshop that can preview photos. Photoshop allows you to set up a proof view in the “View” menu. This
allows you to simulate how your image will look in certain print conditions.

Photos in eBooks and on the web may not reproduce with the same colour as the original photo unless the

photographer and web surfer are using the same colour profile.

Figure 6-1. Original RGB image (left) and same image as it would appear printed on newsprint (right).

Resolution. Users want photos that reproduce with sharpness and detail. Generally printers—be they home inkjet
or laser, commercial inkjet or digital, or lithography—will break down image pixels into microscopic halftone
dots or random-dot screens. Generally, images with a resolution of twice the screen ruling will reproduce well.
Those with lower resolution will reproduce with a “stair-stepping” or “pixelized” effect in which readers can see
individual pixels, or image squares (Figure 6-2). Higher-than-necessary resolutions may result in large file sizes
that create even larger page layout documents, and these can be difficult to transport, email, upload, download,
and process.
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Figure 6-2. Same photo at normal (72 ppi) resolution (left) and 18 ppi (right).

Download time. Web and eBook publishers also want high-quality images but at the same time want to avoid
excessively large files that take a long time to display or to download. A 2016 study by the BBC revealed that the
average user is willing to wait only 3 sec. for a shopping site to open before moving on to another site. For this
reason, it’s wise to size images no larger than will be necessary for the maximum anticipated screen size.

Home Inkjet/Laser

User #1 has a home colour inkjet or laser printer. He or she wants to print single copies or at times a few copies to
hand out at meetings. His printer uses random-dot, or stochastic, screening to print microscopic toner particles or
ink droplets (Figure 6-3). The printer has a built-in driver that’s designed to accept RGB images.

This user wants images with good resolution, with lack of “jaggies,” or pixelization. He may also want his page
layout file to be small enough to email or transport on a USB drive.

For User #1 we recommend saving images in uncompressed TIFF or high-quality compressed JPEG format at
300 pixels per inch (ppi) resolution. Many desktop printers have a built-in driver that’s designed to accept images
in sSRGB mode and convert them to the printer’s colour system, such as CMYK or CMYKcm (cyan, magenta,
yellow, and black, and light cyan and light magenta). In this case, the best way to get matching colour is to send
the printer files in RGB mode and in the standard RGB (sRGB) colour space.
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Figure 6-3. Halftone dots printed on a flexographic press (left) and on a colour laser printer (right).

Large-Format Inkjet and Digital Print

User #2 wants to get a poster, sign, or banner printed on a large-format printer. Since such printers are rather
expensive and require sufficient space, he would probably bring his page layout files to a sign shop or commercial
inkjet printer.

Large-format inkjet printers are often used with raster image processors (RIPs) that can either be built-in or run on
a PC that connects to the printer. Colour can be matched by using industry-standard profiles that conform to the
International Color Consortium (ICC) specifications. These profiles are often made available by ink and media
manufacturers for specific RIPs and output resolutions.

Our suggestion would be that User #2 leave his images in RGB mode and in a specified colour working space,
such as sRGB (smaller gamut) or AdobeRGB (bigger gamut). The RIP would then convert the colour mode to
CMYXK for the specific colour format, ink, media, and resolution used by the printer.

Similar recommendations could be made for high-volume digital printers that use dry or liquid toner.

Lithography

User #3 wants to use his photos in a book, magazine, catalogue, brochure, pamphlet, newspaper, advertising insert,
or similar job. Offset lithography is suitable for high-quality printed products when more than a few hundred and
up to a million copies are required.

The offset printer most likely uses a PC-based raster image processor (RIP) software to image aluminum printing
plates for the press. The printer may have made a custom ICC profile for the press, ink, and paper being used,
or they may print to an industry specification such as the Specifications for Web Offset Publications (SWOP) or
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General Requirements for Applications in Commercial Offset Lithography (GRACoL), for which ICC profiles
already exist.

Our suggestion for User #3 would be to check with his printer about what file format, colour mode, and resolution
they would prefer for images. Ideally, he would keep his photos in RGB colour space to maximize the colour
gamut and allow the printer’s RIP to make the conversion to CMYK for the specific press being used.

Printed images must be broken into microscopic halftone dots whose size is measured in screen ruling, the number
of dots per linear inch or centimetre. Many printers today are making plates at 150-200 lpi. Some are using
random dot, or stochastic, screening, which produces a more photographic look. Conventional wisdom states that
photos should be twice the resolution of the screen ruling, i.e., an image to be printed at 150 Ipi should be 300 ppi.
However, most printers would probably accept 300-ppi images for printing at 200 Ipi.

For colour-critical jobs, the printer may be able to supply User #2 with an ICC profile to use in previewing, or
“soft proofing,” his images on a monitor.

eBooks

User #4 is taking photos to illustrate an eBook. The publisher plans to release the eBook in multiple formats,
including MOBI for Amazon Kindle, EPUB for multiple eBook readers and tablets, and Apple iBooks for iPads
(Figure 6-4).

For User #4 we recommend considering whether his images will be, for example, half-page or full-page and
whether they can be enlarged by tapping on the screen. In this case, User #4 could consider the maximum
resolution of an iPad with Retina Display is 2048x1536 pixels or double standard HD in both dimensions
(1024x738 px). Therefore a half-page photo that does not enlarge, at 1024x738 px, would reproduce with high
quality.

If using Photoshop to convert digital photos for eBooks, User #4 may find that the program’s File > Export > Save
for Screen or Save for Web features could be handy. These dialogue boxes allow the user to specify output format
and resolution before a file is saved.

A few general guidelines for eBook publishing are that these books are quite often read on relatively small
screens. For example, the MOBI file format for Amazon Kindle has an image size limitation of 64kB, so they
work best with small screens. Some eReaders use elnk displays, which usually are for black & white text and
images. elnk displays are not as energy-hungry as tablet displays. elnk displays are used in Kobo eReaders. The
advantage of eInk displays is that they can be read in full sunlight. A disadvantage is, that they don’t switch pages
quickly. Images for eReaders should be in sSRGB colour space.



CHAPTER 6 + WORKING WITH PRINTERS, WEB, AND EBOOK PUBLISHERS (MARTIN) + 59
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User #5 wants to place photos on the web. In this case, he or she could consider whether a photo will be
reproduced at a half-page or full-page width. Surveys say that the typical screen size in use today is 1366x768px,
therefore a half-page image 683px wide and 72 ppi should reproduce with good quality. An example of an
increasingly popular high-resolution display is the iMac 4K, which is 4096x2304, three or four times standard
HD in both dimensions (i.e., 4x1024 and 3x768).

Table 6-2 below compares the file size and download times of the image in Figure 6-1, which was taken with a
24-MP camera that produced a 6000x4000 pixel image. Keep in mind that, according to the BBC study mentioned
above, users are only willing to wait 3 sec. for an entire page to load.
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Table 6-2. File Sizes and Download Times

compression file size (MB) download time (sec.)
none (6000x4000-px image) 34 176

JPEG-Max (100%) 19.9 103

JPEG-Very High (80%) 10.8 56

JPEG-High (60%) 6.2 33

JPEG-Med (30%) 2.77 15

JPEG-Med (30% and res. 4096px wide) 1 6
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Pricing Digital Photography

Digital photography can result in lower downstream costs if processed correctly for file format and color-
management of images. It can let you take advantage of automated print technologies. Progressive printing
companies realize this competitive advantage in controlling the photography. Digital processes make this all
possible.

Professional photography can take many forms. A photographer may capture images on speculation, offer these
images as stock images and license them on a per use (royalty) basis. A photographer may work for a publisher
and be compensated for capturing the image and still retain copyright and continue to license the image for use
to others who would find value in using the images. Or a photographer may work for a media company such
as a printer as a regular salaried employee. In the latter two forms the employer may require the photographer
to relinquish copyright, ownership and any future compensation for the images captured. If the images are for
marketing purposes that clearly contain images of the client’s products and services this may best represent the
interests of the client. These images that are only of value to the client allows the client to reuse the images many
times without further cost.

Although this chapter concentrates on work-for-hire assignment photography, photographers specializing in stock,
freelance or other forms of photography may be able to utilize applicable concepts from this chapter for their own
use.

Copyright, Ownership and License Fees

Pricing of professional photography, should take into account copyright ownership and licensing considerations.
The Copyright Act generally gives ownership and copyright of the photographic work to the creator who is
then free to determine the current price and any future royalties. This is often the case for freelance or stock
photography work.

Photographers who have copyright ownership may determine license and royalty fees depending on a wide variety
of factors. These include the type of product or media it is to be reproduced in, the quantity of the circulation or
print run, the page or image reproduction size, the time frame for which it is to be used, and other factors. Single
use, multiple reuses, exclusive use, unlimited use and outright buyout are part of the compensation equation. This
chapter does not cover license fees in detail as this form of photography is not its focus. The American Society
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of Media Photographers (www.asmp.org) provides more information about copyright and license fees. The U.S.
Copyright Office (www.copyright.gov) provides information about your rights.

Photographers may work on a salary basis and receive health benefits from their permanent place of employment.
In this case the employer may claim the right to ownership and copyright of the photographic images created by
the employee. When photography is commissioned by and paid for by the client, as a “work-for-hire’ photography
assignment, the client may retain ownership and copyright of the photographic images. Often these images clearly
show the client’s products or services and may have little commercial value except to the client for whom it was
originally commissioned by, to be reproduced in print or other media.

Print media companies that offer digital photography as an ancillary service usually offer the service as a
“work-to-hire” assignment with the copyright ownership being transferred to the client. The printing company is
sufficiently compensated through the markup on both the photographic and printing services and the photographer
as a full-time permanent employee receives a fair salary plus benefits and permanent employment. This is in
contrast to a freelance photographer who is self-employed and may work a limited number of days in a year,
and have a career that spans less than that of a salaried employee. They must do their own sales, marketing and
bookkeeping and self-employed photographers are also responsible for their own health benefits and retirement
savings.

Steps to Accurately Price Photographic Work

The steps below are those used in the printing industry that lead to accurate pricing of printing. This chapter will
lead you through a similar process in determining the costs and pricing for digital photography.

Table 7-1. Steps Leading to Estimating Prices for an Assignment

» Calculate or update hourly charge-out rates.

Annually ) ) .
» Determine or revise operations standards.
 Estimate labour hours and costs using established
operations standards and hourly charge-out rates.
Per » Estimate materials quantity and costs.
estimate » Estimate cost of outside purchases.

 Add profit markup to establish selling price.

» Produce typewritten quotation.

The first step is to calculate what it costs you for an hour of your time. This rate will become your Budgeted
Hourly Rate (BHR) or charge out rate. You may decide on different rates for different operations or cost centers.

The second step is to determine the standard time (based on standard operating procedures) it takes to perform a
particular function.
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Once you have these two you can calculate the cost of a particular operation.

Cost versus Price

Estimating costs and adding a profit markup to determine the selling price are distinct and separate steps in
a customized process such as photography assignments or commercial printing. The standard cost estimating
formula is:

Cost estimate = (Production standard x charge-out rate)
+ cost of materials + outsource purchase costs

Once you have established your costs you can add a profit markup to determine your selling price. The standard
selling price formula is:

Selling price = Estimated cost + Markup

Capital Investment and Setup Costs

The following charts illustrate the potential starting costs between the different commitment levels in offering
digital photography services. Costs stated are used to make a point and your exact costs will vary depending on
your own investments.

If you are to produce high quality images suitable for sheetfed offset printed reproduction on coated paper printing
at 150 LPI at 300 DPI (2 x LPI) you will need a camera that produces enough optical pixels. It may be that you
are assigned to shoot a double page spread of an 8 %4” x 11” saddle stitched magazine with bleeds in which case
your image will need to be at least 11 %4” x 17 %4”. Or you may be assigned to shoot a 19” x 25” or 25” x 38”
poster.

Low-End Investment

Point & shoot 6MP $250
Computer — existing $0
Software (Adobe CS suite, etc.) $2,000

Total $2,250
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Prosumer Investment

Nikon 12MP $6,000
Computer (Mac) $3,500
Software (Adobe CS suite, etc.) $2,000
Total $11,500

Professional With Small Studio

Hasselblad 39MP (body, lenses, backs) $30,000
Lights, power supply, umbrellas $1,500
Backdrop, props $1,500
Studio construction $10,000

Computer (Mac Pro), high-end monitor, and proofing device $18,500

Software (Adobe CS suite, etc.) $2,000
Business management software $1,500
Total $65,000

The above charts illustrate the typical costs for an entry-level digital photographic setup. Annually you will need
to replace, upgrade or add cameras, lenses, backs, lighting, studio props, computers, software and upgrade or
reconfigure facilities. By calculating your hourly and daily charge out rates based on adding an annual budget of
approximately 50% of your startup costs will ensure that your equipment will stay current over time. A magnitude
increase in capacity will require a significant ramp up in investments and a recalculation of your charge out rates.

If you specialize in shooting food product shots in your studio you will need to install a refrigerator and stove,
plus account for food costs and maybe even a chef. Don’t forget to account for storage space and hauling of waste.
Approved lighting may also be necessary for viewing proofs.

The photographer must invest in robust computer hardware and software solutions, and training. A color managed
MAC is used for creative, editing, manipulation, marketing collateral design, web site design and maintenance,
viewing images, asset management. These costs of are not trivial. Image editing requires a fast computer with
relatively expensive software. Computer hardware (RAM, hard drive, backup systems) and software will need to
be upgraded on average every one to two years.

Determining Your Hourly Charge Out Rate

The process of determining your hourly charge out rates is a detailed process that is in itself very enlightening.
You can use this time of self-examination to review all of your business processes, procedures, policies and costs
in detail to determine if a general fine-tuning of your business or a more systematic process such as reengineering
of your business operations is appropriate.
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You may need to employ an accountant to assist in accurately deriving the values of fixed and variable overhead
expenses of your operation. Once these values are compiled they can be entered into a Budgeted Hourly Rate
(BHR) spreadsheet such as the one on the next page.

Running a lean operation and controlling expenses and maximizing are ways to reduce your charge out rate and
assist in growing your business and increasing profits. Optimizing levels of efficiency, productive (chargeable)
hours, waste and spoilage, real estate costs, salary and employee benefit costs, sales and marketing costs, bad
debts are necessary to control your hourly charge out rates.
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Facilities

gardening, snow removal $2,500

garbage removal 750

janitor 1,250

insurance 2,500 key man, property, E&OE

lease or rent 12,000

utilities 1,250 light, heat, water

repairs & maintenance 500

security 1,800

licenses, permits, taxes 500

external storage 1,500
$24,550

Studio

cameras, lighting, props $10,000  50% reinvestment annually

computer 1,250 hardware & software

depreciation 2,250

salaries & burden 95,000 photographer + assistant
$108,500

Admin—Office

computer $750

furnishing 500

depreciation 375

telecommunications 2,500 land/fax lines, cel, internet

web site 750 design, maintenance, hosting

office supplies & postage 1,000

legal & bookkeeping 1,725

shipping & couriers 500

education 1,000 2 continuing education courses
$9,100

Marketing

printing $3,500 business cards, brochures

trade shows 2,000 1 local, 1 at a distance

supplies 1,250 paper, toner




CHAPTER 7 + PRICING DIGITAL PHOTOGRAPHY (ART) + 67

advertising 3,000 targeted trade magazines

associations 2,000 photo & print association fees

travel 2,500 attend 1 trade show

entertainment 1,800 entertain clients

donations 500 local midget baseball team

automobile 4,000 lease, insurance, gas, maintenance
$20,550

Subtotal $162,700

markup @10% $16,270

TOTAL $178,970

40 hours/week x 48 weeks/year 1,920

BHR at productivity of 65% $125.84 1,248 hours chargeable annually

BHR at productivity of 70% $121.18 1,344 hours chargeable annually

BHR at productivity of 75% $116.52 1,440 hours chargeable annually

BHR at productivity of 80% $111.86 1,536 hours chargeable annually

Calculate your total annual expenses. Divide by the number of sellable (productive) hours. Use the spreadsheet
for “what-if” scenarios. i.e. What if we are able to bring enough business in to run on a two shift basis and spread
overhead costs over more hours? You can use your hourly rate to determine a daily or half day rate.

The values in the above sample spreadsheet are based on a two-person one-shift operation, with the owner/
manager being the photographer and one multi-tasking assistant. Some shops use separate columns for different
equipment or operations to determine more detailed charge out rates. Note how the charge out rate changes based
on the number of chargeable hours increases. Multi-shift operations with enough volume are able to reduce hourly
charge out rates.

Estimating Fees

Photographic fees can be categorized as assignment specific creative fees, non-creative fees, expenses and
miscellaneous costs, as shown in the charts below. Creative and non-creative fees are generally performed by in-
house professionals and time estimated is based on production standards and costs estimated based on established
charge-out rates. Expenses are generally assignment specific costs paid to outside individuals or companies.
Miscellaneous charges cover lost production time caused by mother-nature or the client.
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Creative Fees

Color correction

Digital capture

File conversion

Image manipulation

Proofing / web gallery maintenance

Reshoot

Non-creative Charges

Casting

Consulting
Coordination
Preproduction
Postproduction
Research & Testing

Travel time
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Expenses

Crew / driver / grip / janitor

Couriers / messengers / shipping

Insurance

License & use fees

Location costs

Props

Rentals: sets, studio

Rentals: lighting, camera equipment, computer, monitor
Security / police

Talent

Transportation (taxicab, car rentals)

Travel (air, hotel, airport transfers, taxicabs, meals, per diems)

Wardrobe

Miscellaneous

Cancellation
Postponement
Weather delays

Value factors — special markups

Proofs

Many digital photographers choose to provide proofs via a web gallery or as soft proofs. Photographers normally
shoot many more photographs than viewed by the client. Clients may request all images rather than only the
“Photographer Selects”.

Web gallery images may be removed after a few weeks. Some photographers may charge separately for this while
others roll up the cost in the creative prices. There is a cost to purchase or develop and implement this service/
software. Training, upgrades, service and maintenance are costs a photographer will also incur.
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Photographers have begun to include soft proofs in the cost of the image capture. Soft proofing is becoming
more popular with big publishing clients and is starting to trickle down to other operations. The quality of
approved LCD panels has increased, prices have come down, size has increased and there are more people that
understand colour management. The cost of soft proofing may be negligible even when multiple proofs are
required simultaneously in different locations. Some photographers will set up the client to view color managed
soft proof as part of a quality and customer management and customer training programs.

Many clients still like to see hard copy reference prints which are printed using inkjet technology and some require
images delivered on CD-ROM or on DVD disks.

Assignment Costs

Thoughtful planning can assist in reducing costs long term and will reduce unexpected surprises. You still need
to plan for some contingencies because uncontrollable variables may put the shoot off schedule and increase
costs. People show up late, equipment malfunctions and things break. On location other contingencies may be
anticipated, the weather doesn’t cooperate, traffic problems makes participants late. Experience is learning from
past occurrences. Keep a log and share learning amongst staff.

A job may include pre-work such as research and testing in addition to consultation.

Short shoots may not be cost effective. Take advantage of common setups to get more photographs done in the
same shooting day/week so you can share the cost of setups, models, hair stylists, assistants, travel costs and time
and rental equipment.

The digital photographer is now responsible for more creative control that was once part of the scanning and
prepress processes. Color correction, retouching and tone-range compression is now performed up-stream by the
digital photographer. The digital photographer may embed an ICC profile thereby tagging the color preferences
information that has been established.

Digital capture charge could include standard image capture, some editing, proofs, transfer, batch convert,
evaluate, saving and archiving digital files and delivery of images. Meta-tagging by adding keyword captions so
images can be found later is important and time-consuming. You may choose to roll up some or all of these costs
into your prices or charge separately depending on the circumstance.

If you do location shooting you may be need to be concerned about weather days which may result in a
postponement of full cancellation of the shoot. Determine in advance who will absorb the costs should this occur.
You need to build in a number of unproductive days into your costing.

Your Profit Markup and Selling Price

Your profit strategy will likely be multi-faceted but should result in a year-end profit target somewhere around the
printing industry profit leaders of 10% to be sustainable in the long term. Once you have estimated your costs you
should use market based pricing. It is in both your interest and your customer’s interest that you make a healthy
profit. This does not mean gouging your client but rather making such a profit that allows you to stay ahead in
terms of upgrades and offering innovative services and products. Pricing based on perceived value or what the
market will bear makes sense as long as you are not price-gouging. If you price too low and go out of business it
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is neither in your best interest or the best interest of the customer. If you price too high because your costs are too
high you will not attract enough work to cover overhead expenses and will not stay in business in the long term.
Profit is needed to support growth. Growth allows a company to reach a size where economies of scale can be
realized.

Profits are needed so the company can continue to invest in expensive digital hardware, equipment, software that
becomes outdated in one to two years. Profit is also needed for updating premises and for expansion. Employing
top staff and providing extensive training costs money as does R&D. And profit is needed to compensate owners
and investors for their use of capital.

Typical Printing Industry Markups

Labor 10% to 30%
Materials 20% to 50%
Buyouts 50% to 100%

Some customers may need to be educated about what they receive for your price. Other customers buy from
you because you are consistent and predictable in delivery of your promises. From you they receive an optimum
level of quality control, customer service, communication, turnaround, and most of all peace of mind. Customers
appreciate your show of competence, empathy, and how you calm customer’s job related anxieties. All of these
factors have costs implications. This equates to the customer using a cost-benefit ratio and paying an insurance
premium to ensure peace of mind and reduced stress.

Many suppliers have a goal of being a supplier of premium priced products and services. Market skimming is
an approach where a company begins with low pricing and determines which customers have the best long term
profit value, skimming off these customers and favoring these customers for preferential treatment and eventually
dropping off less desirable customers. This approach allows a company to position themselves in upper-end price-
inelastic highly profitable spectrum of the market. You must work to continue to be top-of-mind with the selected
customers by maintaining the desired image. It is hard work to create and maintain a favored-supplier position
(“halo effect”), but worth the effort. Your goal may continue to be low cost while providing either moderate or
high priced products and services thereby maximizing profit.
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Work for Which Special Pricing Might be Warranted

Charity work Discounted
Employee work Discounted
First time customer with long-term potential Discounted
Volume work Discounted
Filler work Discounted
Rush work Premium
Slow paying and delinquent customers Premium
Work during slow periods Discounted
Work with significant marketing and/or PR value Discounted
Environmental levy etc. Premium
Difficult assignment — time and skill involved Premium
Pain in the neck factor Premium
Sltggs] }\igilée — can’t get the photographer’s style Premium
Competitive edge — a gut feel of client dynamics Premium

On certain jobs a company may choose simply to break even (cover costs) or even to price below cost as a loss
leader. This may take place if pricing to buy exposure, to get a foot in the door or to give a client a trial of the
company’s service or product. Too much pricing below cost may lead to disastrous long-term financial results and
is not sustainable long term. The law may prohibit pricing below cost. Pricing must be diligently managed or you
will not achieve your yearly profit target.

Handling the Quotation Request

Getting accurate specifications is the first step to accurately estimating assignment photography costs. Tighter
specifications should result in a tighter price as the estimator is able to use his or her estimating judgment to find
creative solutions to reducing cost without jeopardizing quality.

When determining your price don’t be afraid to ask what your client’s budget is. If you are the preferred supplier
your client may give you this information and maybe even what the competition’s price is as well.

Make your quotation subject to review of final specifications at the time the job is received. Errors and omissions
insurance (E&OE) should be purchased to protect against large mistakes made during cost estimating.
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Provide a written quotation letter with acceptance signature by the client will ensure legal enforcement. It protects
both sides. Make the quotation subject to Trade Customs, Terms and Conditions.

Determine if a deposit of up to 50% in advance is justified with 50% COD. Perform a credit check regularly
throughout your relationship and ask the customer to provide financial statements if you feel necessary. This will
show if the customer is not paying others or if there are lawsuits or judgments. Wise companies regularly monitor
business newspapers and journals for lawsuits and bankruptcies. Not only could you head off potential problems
with customers but you can see what is happening with your competitors as well.

Once the job is in production be sure to track customer changes and get a sign-off on additional costs before
proceeding with the alterations. This is a source a lost profit margin for many vendors.

Establishing Pricelists

Once you know how long it takes to perform a particular operation (standard) and your hourly charge out rates
you can create price lists where you roll up material costs such as for proofs. The following price lists are taken
from a survey of photography suppliers. Although these may get you started you should take the time to determine
your own costs, standards and price lists.

Digital Photography Services

Price range Minimum
Image capture — regular $1 to $2 per image $50 to $150
Master file preparation — regular $50 to $55 per image
Master file preparation — hi-rez $100 per image
Retouching $125 — $150 per hour

Color correction $125 — $150 per hour
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Proofs (color correction not guaranteed)

Price range Minimum

$50 for first 100

Web gallery $20 for additional 50 =

4” x 6” inkjet guide prints $1 $50

Inkjet contact sheets 8 14” x 11” $15 each

Inkjet contact sheets 11” x 14” $25 each

Large inkjet proofs $5 to $8 per square foot

CD-ROM delivery (jpeg or tiff) $2 to $4 per image $25 to $50

Courier or mailing charges are additional

Standard CMYK conversion $65
Greyscale conversion $55
Greyscale & CMYK conversion $75
Web only (small file) $25
Web & CMYK $70

Price charts in this chapter are for illustrative purposes as you should determine your shop’s costs and profit
targets.
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Introduced in 1989, Photoshop is a market-leading image editing program that is useful in web design for opening,
formatting, editing, and saving images for the web.

Image Capture

The best way to capture high-quality images for the web is with a digital single-lens reflex (DSLR) camera,
whether mirrored or mirrorless. Today’s semi-professional and advanced amateur cameras typically capture 20-36
megapixels (MP), and the megapixel capacity increases as new cameras are introduced every year.

Camera raw format captures the full megapixel and density range of the camera, however such large images
are seldom necessary for the web. in fact, they can be detrimental to loading times. Camera Raw includes both
proprietary formats for each camera manufacturer and model, as well as the universal digital negative (DNG)
format.

When opening camera raw format in Photoshop’s Camera Raw plugin (Figure 8-1), web designers should think
about the maximum image size they will need, then use the image resizing feature to get the desired size. The
site websitedimensions.com says that 35% of web surfers use a browser window that’s 1366x768 px, while 20%
use 1920x1080. If this is true then the maximum size window would be 2 MP (1920x1080) and a full-size image
would not need to be larger than that. It may be useful for the designer to think about the anticipated maximum
size of an image as being a full-page, half-page, or quarter-page image. A quarter-page image would need to be
960x%540 or 0.5 MP.

75
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Suggested Photoshop Workflow for Web

1. Set camera exposure, white balance, and depth of field for optimum
photo.

2. Record in camera raw format, bracketing exposures

3. Open photos in Camera Raw plugin, select correct exposure, set image
size, and open

4. Edit as required

5. Export to JPG or PNG using Export > Save for Web.
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® Camera Raw 10.0 - PENTAX K-r

Filmstrip

finn 050s
IS0 200 1B-55@43 mm

1_Firebird.dng d SEMAMEISNAABE®

Basic
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Shadows
Whites

Blacks
3_Firebird.dng

Clarity
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Saturation

EE 541% ~ 2_Firebird.dng 4 »  Image 2/3

Save Image... Adobe RGB (1998); 8 bit: 2677 by 7 (6.6MP); 300 ppi Cancel

Figure 8-1. Photoshop’s Camera Raw dialog box offers the opportunity to open several photos camera raw files at once, make settings, and
save in standard formats. In this case a bracketed series of exposures (i.e., one slightly too dark and one too light) was taken with a 24-MP
camera. The best photo was opened at a resolution of 72 ppi and size appropriate for the web.

“Toning” Images

If you have a bracketed series of exposures, several features of Photoshop are useful for choosing the best image
and preparing it for publication.

Obviously it’s easier to see the quality of a photo on a large-screen computer monitor than on a camera’s 3-inch
display. However Photoshop and other programs also allow you to compare photos “by the numbers” by reading
highlight and shadow values.

The lithographic printing industry took a systematic approach to image toning, based on the largest and smallest
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halftone dots that a press can typically reduce. Measured on a scale of 0-100% dot area, most presses can
reproduce 3% highlight dot and a 97% shadow dot.

For images on the Web, monitors display color on a scale of 0-255 levels, where level 0 is black and 255 is white.
Applying the 3-97% minimum-maximum to the levels scale: 3% of 255 is 7.65, or 8 when rounded; while 97% of
255 is 247.35, or 247 (Table 8-1).

Table 16-1. Highlight and Shadow Dot Values

Highlight  Shadow

% Dot Area for Print 3% 97%

Levels for Web 247 8

To select the best exposure from a bracketed series, make sure the file has no levels above 247 or below 8. After
selecting the best image from a bracketed series, you can further “tone” the image (Figure 8-2) by adjusting
highlight, shadow, midtone, gray balance, and color.

sTovrrEs sTovrrEs
OPAQUE OPAQUE
SENSITIVITY SENSITIVITY
GUIDE

Figure 8-2. Original (left) and toned (right) images. On the right-hand image, highlight and shadow were set at 247 and 8 levels,
respectively, to bring out the maximum contrast in the image.



CHAPTER 8 + PHOTOSHOP (RICH & JASON) + 79
Making Transparent PNG Files

If your image contains one or a group of subjects that you want to publish on the Web without the background,
save the image as a PNG file with transparent background (Figure 8-3).

First, make a selection path around the object(s) you want to isolate from the background. Then right-click on the
selected subjects and choose “New Layer from Cut.” Select the background layer and set its transparency to 0%.
Save for Web in Photoshop, check the Transparency option, and verify in the preview.
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Figure 8-3. Making a transparent PNG file by selecting the object, bringing it to a new layer using “New Layer via Cut,” deleting the

background, and Export > Save for Web with Transparency checked.



CHAPTER 8 + PHOTOSHOP (RICH & JASON) -« 81
Saving Images for Web

Once an image has been opened and edited in Photoshop, it can then be saved in a format suitable for web (JPG
for photos and PNG when transparency is required) using the Export > Save for Web feature. This dialog box
(Figure 8-4) includes settings for image format, transparency, size, and resolution.

@ Save for Web (100%)

w G:J Tip: Use File > Export > Export As... or right click on a layer for a faster way (P Learn More
l‘-'..
- Preset: [Unnamed]

Optimized
JPEG
Maximum v Quality: 100
Progressive Blur: 0

[ Optimized vatte: [N

Embed Color Profile

[ Convert to sRGB

Preview: Monitor Color
Metadata: Copyright and Contact Info

Color Table

Image Size

Percent: 100

pX
I

] ~ S

px Quality: Bicubic

100 guality

Animation

= 100%

Preview...

Figure 8-4. Photoshop’s Export > Save for Web dialog box offers the opportunity to customize the image format (upper right corner) and
size (lower right) and also includes a prediction of download time (lower left) at various internet bandwidths.

Non-Destructive Editing

As a bitmap image-editing program, Photoshop enables users to change the tone and colour, along with the pixel
content, of images. This is known as destructive editing because the original characteristics are altered.

Non-destructive editing is done through layers and masks and preserves the original pixel information. There are
three reasons why non-destructive editing is useful:

1. Preserving the original. Since non-destructive editing preservers the original pixels, you can always go
back to the original image if you don’t like the results of your edit.

2. Making a record. Non-destructive edits provide a step-by-step record of changes, so that you can later
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go back to them. This could be useful when editing for a client, to show what edits were made and
justify the time spent making them.

3. Working faster. Editing via layers and masks allows you to organize your edits, see what you are doing,
and work faster and more efficiently.

Tools for Non-Destructive Editing

Layers. A fundamental concept of non-destructive editing is to apply edits to Photoshop Layers. Adding a layer is
like placing a clear plastic overlay on top of a photographic print, and making the edits on the plastic. The effects
of the edit layer can be applied to the layer(s) below, then turned on and off to visualize the photo with and without
the edits.

Layer Masks. A Layer Mask accompanies a Layer and can hide or show part or all of the effects of the Layer.

Adjustment Layers. This type of Layer applies Image > Adjustment effects, such as Brightness/Contrast, Levels,
Curves, and others, via a Layer, so that changes are non-destructive.

Layer Styles. A Layer Style adds effects to another layer, such as a drop shadow, emboss effect, gradient, or other
effect.

Smart Objects. These include placed images and image components whose original pixel data is preserved after
edits. Let’s say you place a logo or other image into an existing image and then want to reduce its size. If first
converted to a Smart Object, Photoshop will retain all the pixels in the original logo so that it could be enlarged
later.

Smart Filters. These are Filters applied to Smart Objects so the effects of the filter can later be removed or
modified.

Content Awareness. A form of artificial intelligence, content awareness examines neighbouring pixels and uses
them to fill in spaces, move objects, and resize images.
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Figure 8-5. People were removed from this beach scene using Photoshop’s Content Aware Fill feature. Marquis were drawn around each
object to be removed, then Edit > Fill was selected and set to Content Aware. (Photo by Jason Lisi.)

Tips for Non-Destructive Editing

10. Duplicate a Layer. Let’s say you open a digital photo in Photoshop and want to make some edits. The
fastest way to edit non-destructively is to duplicate the Background Layer into which the photo is
opened. Simply drag the layer to the New Layer icon in the Layers palette to duplicate it. Or select the
layer and choose Duplicate Layer from the Layers menu or the upper-right popup menu in the Layers
palette.

11. Retouch through a Layer. When retouching defects, artifacts, or undesirable features of an image, the
Clone Stamp, Healing Brush, and Spot Healing Brush tools can be applied through a Layer (Table
8-3). Simply check “Sample All Layers” or choose “Current and Below” from the popup in the
Properties menu. (Not all tools work through layers, see Table 8-4. In this case, duplicate the layer
before retouching it.)

Table 8-2. Retouching Tools that Work through Layers

Clone Stamp Tool

Healing Brush Tool

Spot Healing Brush Tool
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10.

11.

12.

13.

10.

11.

12.

Table 8-3. Retouching Tools that Don’t Work through Layers
(duplicate layer first)

Content-Aware Fill
Content-Aware Move

Content-Aware Scale

Use an Adjustment Layer to Change Tone or Colour. To improve contrast, brightness, highlight,
shadow, gray balance, selective colour correction, and other adjustments, apply an Adjustment Layer
to make these changes non-destructive.

Apply a Layer Effect. Layer Effects make it easy to add a colour blend, metallic effect, drop shadow,
and many others in a non-destructive manner.

Use a Layer Mask. A Layer Mask hides, shows, or alters the appearance of its associated layer.
Example: If you apply a colour fill to a layer, the colour can be selectively applied using a Layer Mask.
Painting or filling with black negates the effect of the associated layer, while painting with white or the
Eraser Tool reestablishes the effect.

Use a Smart Layer for Filters. Photoshop features dozens of filters that can add noise, sharpen, smooth,
and otherwise alter the appearance of images. Applying them as Smart Filters to a Smart Object
preserves the original appearance of the object or layer.

Table 8-4. Layer Types in Photoshop

1. Layer

2. Layer Mask

3. Layer Effect

4. Adjustment Layer

5. Overlay

Place Smart Objects for Resizing. When another file, such as a logo, is placed into an existing file as a
Smart Object and resized, Photoshop retains all the pixels in the original. This enables the size to be
readjusted without loss of information.

Use Content-Aware Scale to Resize. One of several content-aware features, Content-Aware Scale uses
artificial intelligence to resize images while retaining the original scene objects.

Use Content-Aware Fill to Remove. This feature is useful for removing objects from scenes, such as
people on a beach. Select the object(s) with one of the selection tools, then apply Edit > Fill > Content-
Aware.
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13. Use Content-Aware Move to Move. If you want to relocate an object instead of deleting it, the
Content-Aware Move tool examines surrounding pixels near the source and destination to make the

moved object(s) blend in with the new background.

Figure 8-6. This neon type effect was created from a path using Layer Styles.
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Table 8-5. Layer Types in Photoshop

1. Layer

2. Layer Mask

3. Layer Effect

4. Adjustment Layer

5. Overlay



Appendix * Image Credits

Image Credits
Chapter 4 — Colour Management

Figures 4-4, 4-7.“Adobe® Photoshop® screenshots reprinted with permission from Adobe Systems
Incorporated. Adobe® and Photoshop® are either registered trademarks or trademarks of Adobe Systems
Incorporated in the United States and/or other countries. Screen captures cannot be cropped further.”

Chapter 8 — Photoshop

Figures 16-1, 16-3, 16-4. “Adobe® Photoshop® screenshots reprinted with permission from Adobe Systems
Incorporated. Adobe® and Photoshop® are either registered trademarks or trademarks of Adobe Systems
Incorporated in the United States and/or other countries. Screen captures cannot be cropped further.”
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